Biology 347 General Physiology Lab
Psychophysiology:
The Galvanic Skin Response
Objectives
•
•
•

Students will measure the tonic level of skin conductance, the frequency of spontaneous conductance responses,
and the habituation of the skin conductance response.
Students will observe and measure the GSR as an orienting response to being asked neutral content questions.
Students will observe and measure the GSR to questions with emotional content.

Introduction
The Galvanic Skin Response (GSR) is one of several electrodermal responses (EDRs). EDRs are changes in the electrical
properties of a person’s skin caused by an interaction between environmental events and the individual’s psychological
state. Human skin is a good conductor of electricity and when a weak electrical current is delivered to the skin, changes
in the skin’s conduction of that signal can be measured. The variable that is measured is either skin resistance or its
reciprocal, skin conductance. According to Ohm’s Law, skin resistance (R) equals the voltage (V) applied between two
electrodes on the skin divided by the current passed through the skin (I). The law can be expressed as R=V/I.
A GSR amplifier, like the one that will be used in this experiment, applies a constant voltage to the skin through
electrodes. The voltage is so small that it cannot be perceived. The current that flows through the skin, as the voltage is
applied, can be detected and displayed. Because the constant voltage applied to the skin is known and the current flow
can be measured, the skin’s conductance can be determined by the GSR amplifier. The output of the GSR amplifier is
the skin’s conductance expressed in units called microSiemens ( S).
Two types of skin conductance are characterized, tonic and phasic. Tonic skin conductance is the baseline level of skin
conductance, in the absence of any particular discrete environmental event, and is generally referred to as Skin Conductance
Level (SCL). Each person has a different SCL, with typical tonic levels ranging from 10- 50 S. Tonic skin conductance
levels vary over time in individuals depending on his or her psychological state and autonomic regulation.
Phasic skin conductance is the type that changes when events take place. Discrete environmental stimuli (sights, sounds,
smells, etc.) will evoke time related changes in skin conductance. These are generally referred to as Skin Conductance
Responses (SCRs). SCRs are increases in the conductance of the skin which may last 10-20 seconds followed by a return to
the tonic or baseline level of skin conductance (SCL). These phasic changes are often simply called GSRs. Individuals will
show spontaneous GSRs, that are not event related, to varying degrees. The typical frequency of spontaneous GSRs is
between one and three per minute. Some persons are highly reactive with considerable spontaneous generation of GSRs,
and others have a relatively steady tonic level of skin conductance without spontaneous GSRs. Some of these individual
differences are discussed in another section of this experiment.
The parameters of event-related GSRs that can be quantified are: amplitude, in microSiemens; and latency, rise time, and halfrecovery time, in seconds. These parameters can be determined from a recording.
The amplitude of an event-related GSR is the difference between the tonic skin conductance level, at the time the
response was evoked, and the skin conductance at the peak of the response. Latency is the time between the stimulus
and the onset of the event-related GSR; latency values should be about three seconds or less. Rise time is the time
between the onset of the event-related GSR and the peak of the response; typical values for rise time are one to three
seconds. Half-recovery time is the time between the peak of the response and the point after the peak when the
conductance returns to an amplitude that is one-half the amplitude of the peak; typical values for half-recovery time are
two to ten seconds.
The Electrodermal System
The skin is a three-layered (epidermis, dermis, subdermis) adaptive organ which aids in the maintenance of the body’s
water balance and core temperature. These functions are carried out by blood vessels and eccrine sweat glands. The
blood vessels constrict and dilate to deliver blood flow to the surface of the body for heat conservation or loss. The
eccrine sweat glands function to cool the body by depositing moisture on the skin surface through ducts (in the dermis)
and sweat pores (in the epidermis). The glands, which are located in the subdermis over most of the body, are about ten
times more dense on the palmar surface of the hands and soles of the feet.

The most widely accepted model of skin conductance is the sweat circuit model proposed by Edelberg (1972). According
to this model, phasic changes in skin conductance occur when the sweat ducts in the epidermis fill, and skin conductance
recovers to tonic levels when the moisture is deposited on the skin or reabsorbed by the sweat glands.
In Edelberg’s model, the sweat ducts act as variable resistors; their resistance lowers (conductance increases) as they fill
with sweat. The amplitude of the change in conductance depends on the amount of sweat delivered to the ducts and on
the number of sweat glands which are activated.
Sweat gland activation is a simple physiological survival mechanism, which is of interest in psychology because it is a
neural response. This activation is controlled by the brain via the sympathetic division of the autonomic nervous system.
Human sweat glands receive primarily signals from sympathetic cholinergic fibers that use the neurotransmitter,
acetylcholine. This is an anomaly because most sympathetic fibers utilize norepinephrine. Edleberg (1972) described
three descending pathways for regulatory control over the sweat glands:
• the premotor cortex descending through the pyramidal tracts;
• the hypothalamus and limbic system;
• the reticular formation.
Individual Differences in Electrodermal Activity
In the 1950s, Lacey and Lacey first described individual response patterns that have become commonly accepted as
relatively reliable personality trait characteristics. Individuals, who show a high frequency of spontaneous skin responses
and habituate slowly to repeated presentations of simple stimuli, are termed electrodermal labiles. In contrast, individuals,
who produce few spontaneous skin responses and habituate rapidly to simple stimuli, are termed electrodermal stabiles.
Additionally, these traits have been correlated with a number of psychophysiological variables (Schell, Dawson, & Filion,
1988). Persons typed as electrodermally labile are generally better at vigilance tasks and show a lower vigilance decrement
over time than electrodermally stable persons. Some researchers believe that electrodermal lability/stability represents a
fundamental difference in the information processing characteristics of individuals (Schell, et al., 1988).
Psychosocial Events and Skin Conductance
Electrodermal activity correlates positively with the novelty, intensity, emotional content, and significance of the
stimulus. In each of these contexts, an orienting response (OR) is activated in the central nervous system. The orienting
response is the neural equivalent to: “Hey, pay attention to this; it might be important for your survival!” Both tonic and
phasic skin conductance are influenced by psychosocial contexts.
It has been shown that tonic skin conductance levels rise in anticipation of performing a variety of tasks and during the
performance of these tasks. Common tasks that have been used in experiments to demonstrate this phenomenon
include: mental arithmetic, vigilance/ attention tasks, and social tasks (like, discussing a social issue with others).
Phasic skin conductance responses have been studied in a variety of contexts. The field of social psychophysiology
utilizes skin responses as indicators of social empathy, embarrassment, and social attitudes. Electrodermal activity is
considered a highly sensitive indicator of the social significance of an event. The most common use of electrodermal
activity has been in the detection of deception, the so-called “lie detection test.”
The Polygraph, or Lie Detection Test
The test used to detect the truthfulness of an individual’s statements is often referred to as a polygraph. A polygraph is
actually a multi-function chart recorder that measures GSR, heart rate, blood pressure, and respiration rate. These four
responses are sensitive to stimulus novelty, intensity, emotionality, and significance. The device is operated by a person
known as a polygrapher, who is trained and licensed to administer and interpret the test with the art and science of the
discipline. Polygraphers use a variety of tools to detect deception, including highly standardized questioning procedures.
The use of polygraphs to detect lying in individuals accused of crimes is highly controversial, in part because the
identification of false positives occurs in about 10 to 15% of test cases. A false positives occurs when the polygrapher has
determined that the person is being deceptive when, in fact, he or she has not. A much rarer occurrence is a false negative.
A false negative occurs when the test indicates the person is telling the truth, but he or she is actually guilty. For this reason,
polygraph tests are often used in support of a person’s truthfulness, but not as evidence of guilt.

Procedure: Equipment Set-up
1. Connect the iWorx unit to the computer. Plug the finger electrodes into the input BCN connection of the GSR
meter. Plug the BCN-DIN cable from the GSR meter into Channel 4 on the iWork unit. Open the Labscribe
program.
2. When the program opens, select Load Group from the Settings menu.
3. When the dialog box appears, select IPLMv3.iws. Click Load.
4. Click on the Settings menu again and select the GSR settings file.
5. After a short time, LabScribe will appear on the computer screen as configured by the GSR settings.

Procedure: Calibration of GSR Meter
1. Pull down the Window menu on the LabScribe Main window and select Preview. Click the arrows at the top
of Preview window to select the on-line display of the GSR channel (CH 4). Use the offset knob on the GSR
amplifier to move the observed output to zero. Click the OK button on the Preview window.
2. The GSR-100 amplifier is factory calibrated so that an output of 1 Volt is equal to 5 microSiemens ( S).
3. To enter this conversion factor into the recording settings, pull down the Edit menu in the Main window, and
select Preferences and go to the Channels window.
4. Under the Calibration section of the Channels window, the following settings should be used:
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5. Select one person from your group to be the subject. Ask the subject to go to the sink, wash his or her hands
with soap and water, and dry them thoroughly. Washing the hands insures that surface oils or other substances,
which might lower skin conduction, are removed. Do not use alcohol to clean the fingers, alcohol dehydrates the
skin.
6. The subject will be sitting with his or her back to the monitor, so use the hand closest to the iWorx equipment.
Attach the GSR electrodes to the palmar surface of the distal finger segment on two non-adjacent fingers,
usually the index finger and the ring finger. Attach the electrodes with the Velcro straps so that the straps are
snug, but not overly tight.

Procedure: Tonic SCL and Habituation
1. There are two measurements in this exercise:
o Tonic Skin Conductance Level: The subject sits quietly, without moving, for one minute as his or her
skin conductance level is recorded.
o Habituation: The subject sits quietly, without moving, while his or her SCL is recorded, Then, ask the
subject the question: “Is your name, X?”, where X is his or her real name. The subject should respond:”
Yes”, each time the question is asked. Ask the subject the same question after his or her skin response
has occurred, and the subject’s SCL has returned to or near the baseline. Repeat this questioning
procedure until the subject shows no response on three consecutive trials. Lack of responsiveness is
considered habituation.
2. The subject should rest his or her hand with the GSR electrodes comfortably. The GSR electrodes should be
free from any extraneous pressure and the electrode cable should be hanging freely. Instruct the subject not to
move the hand during the recording process; movement will introduce artifacts into the recording.
3. Click Start. Type the subject’s first name and the words “1st Tonic SCL” on the comment line to the right of the
Mark button. Press the Enter key on the keyboard. Since the GSR amplifier was zeroed in the Equipment Setup
section of this exercise, the value displayed on the GSR channel (CH 4) is the tonic skin conductance level (SCL)
of the subject. This value should be between 2 and 20 S. Record the subject’s tonic value in table 1.
4. After recording the subject’s tonic SCL, use the offset knob on the GSR amplifier to adjust the SCL value to
zero. Record for a few minutes to make sure the recording is stabile. Click Stop to halt the recording.
5. The next task is to test the subject’s habituation. Click Start, and then click AutoScale for Channel 4. Type the
words “Is Your Name, X?” (where X is the subject’s name) on the comment line to the right of the Mark
button. Press the Enter key on the keyboard as the subject is asked: “Is your name, X?”

6. Continue to record. Again, type the letters “IYNX” on the comment line. When the subject’s response has
occurred and his or her skin conductance has returned to or near the baseline, press the Enter key and ask the
question, again.
7. Continue to record and ask the question until the subject shows no response to the question for three
consecutive times. Click Stop to halt the recording.
8. Save the recording.

Procedure: Data Analysis
1. Scroll through the data file and locate the recording of the subject’s tonic skin conductance level (SCL).
2. Use the Display Time icons on the LabScribe toolbar to adjust the time displayed on the Main window, so that
the complete recording of the subject’s tonic SCL can be viewed on the screen.
3. Count the number of times that spontaneous skin responses occurred during the 1-minute tonic skin
conductance period. To be counted as a response, the change in the SCL must be an upward deflection equal to
or greater than 0.05 S. The SCL will not always return to the baseline value before another response occurs.
4. Record this data in table 1.
5. Scroll through the data file and locate the recording of the habituation task for the subject.
6. Use the Display Time icons on the LabScribe toolbar to adjust the time displayed on the Main window, so that
the complete habituation period can be viewed on the screen.
7. To determine the subject’s habituation score, count the number of times the question (“Is your name, X?”) was
asked before the subject habituated. In this exercise, habituation is defined as three consecutive no-response
trials; each time a question is asked, it is considered a trial. The subject’s habituation score should be reported as
the number of trials needed to reach the habituation criterion. Typical habituation scores are between two and
eight trials, or stimulus presentations.
Note: There may be some spontaneous skin responses during this recording process. Do not count spontaneous responses
in the habituation score. Only count the number of times the question was asked and the subject responded to it with an
increase in skin conductance equal to or greater than 0.05 S, within at least a 3-second latency to response onset.
8. Record the data in table 1.
9. This experiment should be repeated for each group member. Class data might be compiled for later
experiments.

Table 1: Tonic SCL and Habituation
Subject

Tonic SCLs (S)

Spontaneous Skin
Response Frequency
(responses/minute)

Habituation Score
(trials before habituation)

Procedure: Orienting Response- Neutral Content
1. Ask the last subject from Exercise 1 to remain the subject for this exercise. Open a new LabScribe window by
selecting New from the File menu.
2. In this exercise, use the number keys 1 through 10 to add comments to the recording. Each number corresponds
to a neutral content question listed in Table 2. Type the number in the comment line, and press the Enter key
on the keyboard to mark the recording when the corresponding question is asked.
3. Instruct the subject to sit quietly, and answer each question truthfully with either a “Yes” or a “No.” The subject
should not elaborate on any answer.
4. Click Start. Type the subject’s first name and the words “2nd Tonic SCL” on the comment line to the right of
the Mark button. Press the Enter key on the keyboard. Observe the subject’s tonic skin conductance level as
done in the above exercise. If the subject’s tonic SCL as changed, use the offset knob on the GSR amplifier to

5.
6.
7.
8.

adjust the SCL value to zero. Record for a few minutes to make sure the recording is stabile. Click Stop to halt
the recording.
Click Start and type the number “1” on the comment line to the right of the Mark button. Press the Enter key
on the keyboard as the subject is asked the first question from Table 2.
After asking the question, wait for the subject’s skin conductance level to return close to the baseline level before
asking the next question. If spontaneous skin responses are also occurring, wait until these responses diminish to
baseline before asking the next question. Continue recording between questions.
Type the next question’s number on the comment line and press the Enter key as the question is asked. Again,
wait for the subject’s SCL to return to the baseline before asking the next question.
When all ten questions have been asked, click Stop to halt the recording. Save the recording.

Table 2: Neutral Content Questions
1. Do you live in a dormitory?
2. Do you like broccoli?
3. Do you have a cat?
4. Are you a senior?
5. Have you ever gone ice skating?
6. Do you sometimes ride a bike to school?
7. Have you ever been to Alaska?
8. Do you have a sister?
9. Were you born in [State or Country]?
10. Are you a psychology major?
Procedure: Data Analysis
1. Scroll through the recording and locate the data for the subject’s skin conductance response to the first question
in the list of neutral questions.
2. Use the Display Time icons on the LabScribe toolbar to adjust the time displayed on the Main window, so that
the complete response to Question 1 can be viewed on the screen.
3. Click the 2-Cursor icon so that two blue vertical lines appear on the Main window. Position one cursor to the
left of the comment identifying Question 1, and other cursor on the descending slope of the response. There is
no need to include the return to baseline.
4. Click the Analysis icon to open the Analysis window.
5. Display the GSR channel (Channel 4) in the Analysis window by selecting it from the Display Channels menu
on the left side of the Analysis window.
6. Drag one of the cursors in the Analysis window to the mark indicating the time the question was asked, and
the other cursor to the peak of the response. Select Value1, V2-V1, and Max from the Table Functions list
and GSR from the Value from Channel menu. These variables and their values, which are displayed in the
table across the top of the Analysis window, correspond to the following:
• Value1 is the subject’s SCL at the time the question was asked.
• Max is the subject’s SCL at the peak of the response.
• V2-V1 is the difference between the SCLs at the time the question was asked and the peak of
the response.
7. Enter data into table 3.
8. Drag the left cursor in the Analysis window to the onset of the skin response; leave the other cursor on the peak
of the response. Select T2-T1 from the Table Functions list and GSR from the Value from Channel menu. The
value for T2- T1 displayed is the rise time of the skin response.
Note: In this exercise, it would not be useful to calculate the latency, which is the time between the
mark indicating the question and the onset of the response. The questions in this exercise are not brief

discrete events; each question is a different length and takes a different time to ask. Latency will be
measured in another exercise in another context.
9. Enter this data into Table 3.
10. Repeat Steps 1 through 9 for the subject’s skin responses to the other nine questions.
11. Enter the values for all four measurements for each question in Table 3.

Table 3: Skin Conductance Changes for Neutral Content Questions
Questions

Beginning SCL Maximum SCL
( S)
( S)

in SCL
( S)

Rise Time
(seconds)

1. Do you live in a dormitory?
2. Do you like broccoli?
3. Do you have a cat?
4. Are you a senior?
5. Have you ever gone ice skating?
6. Do you sometimes ride a bike to school?
7. Have you ever been to Alaska?
8. Do you have a sister?
9. Were you born in [State or Country]?
10. Are you a psychology major?

Procedure: GSR and Emotional Content
1. Use the same subject used in the above experiment. It would be ideal if the subject was naive to the nature of
this exercise.
However, the subject may have read the manual before coming to class and be aware of the purpose of the
exercise. At the least, the subject should be unaware of the sequence of the questions to be asked.
2. In this exercise, the subject will be asked a total of ten questions, seven new questions with neutral content and
three questions of an emotional nature.
3. To randomize the position of the questions with emotional content within the list of questions to be asked,
draw three numbers from pieces of paper numbered 2 through 10. The number 1 is excluded from the draw, so
that the first question will be one of neutral content. The numbers drawn indicate the positions of the
“emotional” questions in the list.
4. Select three questions with emotional content. They should not be intrusive, and they should involve common
emotional experiences.
5. Select seven new questions with neutral content.
6. Instruct the subject to sit quietly, and answer each question truthfully with either a “Yes” or a “No.” The subject
should not elaborate on any answer.
7. Click Start. Type the subject’s first name and the words “3rd Tonic SCL” on the comment line to the right of the
Mark button. Press the Enter key on the keyboard. Observe the subject’s tonic skin conductance level as done
in Exercise. If the subject’s tonic SCL as changed, use the offset knob on the GSR amplifier to adjust the SCL
value to zero. Record for a few minutes to make sure the recording is stabile. Click Stop to halt the recording.

Table 4: Questions with Emotional Content

Table 5: Questions with Neutral Content

• Are you in love?

• Is today (Wednesday)?

• Do you ever cry?

• Did you watch TV last night?

• Does nudity embarrass you?

• Do you like pizza?

• Do you recall your first kiss?

• Have you ever been to a professional

• Does being alone at night frighten you?

baseball game?

• Have you ever seen a tragic auto accident?

• Do you have a car?

• Have you ever heard about a date rape?

• Are you taking a PE class?

• Do you ever hide some of your feelings?

• Do you like to go to movies?

• Do you believe in the practice of “safe sex?”

8. Click Start and type the letter “N” (for neutral) on the comment line to the right of the Mark button. Press the
Enter key on the keyboard as the subject is asked the first question from the list, which is a neutral question.
9. After asking the question, wait for the subject’s skin conductance level to return close to the baseline level before
asking the next question. If spontaneous skin responses are also occurring, wait until these responses diminish to
baseline before asking the next question. Continue recording between questions.
10. Use the same procedure while asking the remaining questions on the list. Label the beginning of each question
with either the letter “N” to indicate a neutral question, or the letter “E” to indicate an emotional question.
11. When all ten questions have been asked, click Stop to halt the recording. Save the recording.

Procedure: Data Analysis
1. Scroll through the recording and locate the data for the subject’s skin conductance response to the first question
in the list of neutral and emotional questions.
2. Use the same procedures used in Exercise 2 to select data in the Main window, display the selected data in the
Analysis window, and use the cursors and functions in the Analysis window to measure:
• The subject’s SCL at the time the question was asked;
• The subject’s SCL at the peak of the response;
• The difference between the SCLs at the time the question was asked and the peak of the response;
• The rise time of the subject’s skin response.
3. Enter the titles and values for these variables into the Journal by either typing them directly or by using the
functions of the right-click menu.
4. Measure the subject’s skin responses to the other nine questions.
5. Enter the values for all four measurements for each question.
6. Determine mean amplitude change and mean rise time of the three emotional questions, and of the seven
neutral questions. Enter these means on Table 6.
7. Compare the statistics for the emotional questions to those of the neutral questions. It is expected that the mean
amplitude change is greater and the mean rise time is shorter for the questions with emotional content than for
the questions with neutral content.

Table 6: Comparison of Skin Conductance Changes for Emotional and Neutral Content Questions

Questions
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
Mean for 7 Neutral Questions
Mean for 3 Emotional Questions

Question
Type
Neutral

Beginning
SCL ( S)

Maximum
SCL ( S)

in SCL
( S)

Rise Time
(seconds)

